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This tutorial will introduce you into editing your Web and Class Pages, setting up server 
communication and installing password protection for single files. 
 
Please find all necessary equipment on the ICCD CD.  
The CD contains: 

- Local Web Pages � blank pages 
- Local Class Pages � blank pages 
- WS_FTP 95 LE � FTP programme 
- Tutorial: Software Training I 
- ICCD forms: letterheads, logos etc. 
- ICCD Power Point Presentation 
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Web Pages � Class Pages 

Class Page Archive 

View Class Pages of previous courses of the Centre for East Asian Studies at 
 
http://www.dresden.iccd-project.net/neo-conf/ 
 

- go to �Neo-Confucianism� 
- browse through the several options, course description, schedule etc., to get an idea of 

what you can do with your Class Pages 
 
To inquire about other technical solutions please view 
http://rcswww.urz.tu-dresden.de/~cstorm/Taiwan/ 
 
 

Getting started 

Use the Windows Explorer to create a new directory in c:\iccd\ 
Choose a short and precise name for your directory, e.g. a short title of your class or your 
name. Please use small letters only. Avoid �spaces� and any special letters. 
 
The directory is called [your directory] in this tutorial hereafter. 
 
Copy the Web / Class Pages� files from your CD into your new directory. (Mark all relevant 
items in the Windows Explorer�s right window and drag & drop them into your new directory 
= c:\ �\your directory) 
 

Open Your Directory in FrontPage 

Click on Start → Programmes → Microsoft FrontPage to open FrontPage, the programme 
which you will use editing your Class Pages. 
If there are differences between the versions FrontPage 2003 and FrontPage 2000 you will 
find both versions explained. (FP 2003, FP 2000) 
 
 FP 2003 FP 2000 
Click on File →  
Open Site� (2003) 
[Open Web� (2000)] 
in the menu bar. 
Select your directory 
and hit Open 
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If a directory is opened the first time, 
FrontPage opens a window. Answer  
the question with �Yes�, because then 
e.g. hyperlinks and references to 
images are updated automatically 
when you move files around or delete 
them. 

 
Next you see the structure of your directory in the work area. 
Double clicking on �Index.htm� provides you with a general view of the Web / Class Pages 
appearance. 
 

 
If you wish to edit single pages please avoid working in this mode. Instead please 
open the content / content_cp folder and open the single files directly by double 
clicking on the respective file name. 

 
[When working with FrontPage 2000 it may occur, that you cannot see the structure of your 
folders and files. Then activate the option View → Folder list.] 
 

 
 
Most of the relevant files can be found in the content (Web Pages) or the content_cp (Class 
Pages) folder. 
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Formally you will be responsible for editing two different and independent web sites: 

1. your local Web Pages giving information about your institute, the project related work 
etc. 
2. your Class Pages, designed especially to meet the needs of teaching a course. 

 
The general file structure is as follows: 
 
Web Page:   
(example for Web Page Dhaka = dh_... Others are li_..., be_..., dd_... respectively.) 
 

 dh_mainpage 
 content 

   archive.htm 
   classpage.htm 
   contact.htm 
   disclaimer.htm 
   home.htm 
   news.htm 

 images 
   al_blau.gif 
   logo_hell_schrift.gif 
   punkt.gif 
   spr_oben.gif 
   spr_unten.gif 
   strich.gif 
   uni_dhaka_blau2.gif 

 left 
   larchive.htm 
   lclasspage.htm 
   lcontact.htm 
   left.htm 
   lhome.htm 
   lnews.htm 

 top 
   top.htm 
 dh.css 
 line.htm 
 outsidel.htm 
 outsider.htm 
index.htm 
 

 
The content folder contains the major files to be edited. 
 
 
 
 
 

The image folder contains several images, i.e. logos. Avoid 
deleting any of them. 
If you wish to add additional images within your pages 
please save them in this folder. 
 
 
 

 
The left folder contains left side frames. Please do not 
change or delete them. 
 
 
 
 

 The top folder contains the top frame. Please do not 
change or delete them. 

 
The remaining files are responsible for arranging the loaded 
files properly on the screen. Please do not change or delete 
them. 
 

 
 



Web Pages � Class Pages: Getting started - 5 - 

Class Pages 
 

 dh_classpage 
 content_cp 

    material 
    Test_open.doc 
     restricted 
     Test_restricted.doc 
     Test_restricted.htm 
   contact.htm 
   description.htm 
   disclaimer.htm 
   home.htm 
   link.htm 
   literature.htm 
   material.htm 
   msgboard.htm 
   partner.htm 
   reports.htm 
   schedule.htm 

 images-cp 
   al_blau.gif 
   logo_hell_schrift.gif 
   punkt.gif 
   spr_oben.gif 
   spr_unten.gif 
   strich.gif 
   uni_dhaka_blau2.gif 

 left-cp 
   lcontact.htm 
   ldescription.htm 
   left.htm 
   lhome.htm 
   llink.htm 
   lliterature.htm 
   lmaterial.htm 
   lmsgboard.htm 
   lpartner.htm 
   lreports.htm 
   lschedule.htm 

 top-cp 
   top.htm 
  dh.css 
  index.htm 
  line.htm 
  outsidel.htm 
  outsider.htm 

 
The content folder contains the major files to be 
edited. 
 
The material folder stores course material i.e. word 
documents, relevant .htm files, scanned book pages 
etc. containing important information for the students 
to prepare for class. 
This material is either open to everybody who might 
visit the page or restricted by password (see below) to 
participants of the course if the material is under 
copyright protection. 
 
 
 
 
 

The image folder contains several images, i.e. logos. 
Avoid deleting any of them. 
If you wish to add additional images within your 
pages, or if students use pictures in their reports please 
save them in this folder. 
 
 
 

 
 
The left folder contains left side frames. Please do not 
change or delete them. 
 
 
 
 
 
The top folder contains the top frame. You will have 
to customise it. (See below). 
 

 The remaining files are responsible for arranging 
the loaded files properly on the screen. Please do not 
change or delete them. 
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[There are two different Class Pages for the Dhaka team: dh_classpage_1 and 
dh_classpage_2.] 
 
Open now the file �home.htm� of your Web / Class Pages. You may enter a welcome 
message and general information about your institute or the course here. 
 
 
When opening a page you are automatically in the Design mode [Normal mode in FP 2000]. 
Here you can type and edit your pages very similar to the use of Microsoft Winword. In the 
beginning you may prefer to use this mode.  
 

The Code mode [FP 2000: HTML mode] enables you to edit your pages directly in 
html encoding. Writing html code provides a better technical quality, but you have to 
have some knowledge of the html code.  
The Preview mode gives you a screen display as should appear later in the web. 

 
You will find the respective buttons in the bottom menu bar.  
 
 

Save the Changes 

After having changed something in one of your pages always save the file, even when the 
page is not finished. You might want to get into the routine of saving changes every 5 to 10 
minutes. As Murphy�s Law also applies to computers, the computer freezes or there is a 
power failure just when you have worked on your Web / Class Pages for hours and hours and 
then all your work is gone. To prevent such frustrating and discouraging events, always save 
your files. There are three ways to do that: 
 

1. click on File → Save 
2. use the shortcut CTRL+s 
3. click on the floppy disk icon  

 
 
You may now like to edit and save another page. 
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Please note that some ordinary tasks allow additional options compared to Winword.  
 
The Edit → Replace task e.g. will ask you whether to process the replacements in the current 
file only or in all files belonging to the site [= all pages belonging to your directory], etc. 
Make sure to choose the radio button fitting to your intentions. 
 
FP 2003: 

 
 
FP 2000 
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Customizing Your Page 

Customizing Your Contact Page 
 
Open contact.htm in the content / content_cp folder. 
 
Insert your ICCD email address into the TO field and save the file. 
 
 
 
Customizing Your Class Pages’ Top Frame 
 
Open top.htm in the Class Pages� top-cp folder. 
 
Insert your name, time and place of your course like in the example below. 
 

 
 
Then save the file. 
 
 
 
 



FTP � Programme: Installation - 9 - 

FTP � Programme 

 
An FTP (= File Transfer Protocol) is a programme enabling you to set up communication 
between your computer (local system) and the server (remote system) containing the ICCD 
domain and subdomains. Normally you will work on your pages on your own computer first 
and only afterwards connect to the server for the uploading procedure. 
 
We will use the WS_FTP 95 LE programme for server communication. It is a free shareware.  
 

Installation 

To install WS_FTP on your computer start the Explorer and open the WS_FTP folder on your 
CD. Then double click on the WS_FTPLE.EXE file. This will start the installation wizard. 
Follow the instructions and choose to be �Student /Faculty member� working �at home�. For 
the rest always choose�Yes�, �Agree� or �standard application�.  
 
You may now run the WS_FTP programme by opening the Start → All Programmes → 
WS_FTP menu and clicking the WS_FTP 95 LE.  
To create a desktop icon, right mouse click the WS_FTP 95 LE and choose Copy. Then close 
all open windows, place the mouse on a free desktop space, right mouse click and choose the 
Insert button. A WS_FTP 95 LE icon will appear on your desktop. The programme may be 
started by double clicking the icon. 
 
 
Before connecting the first 
time to the server a few 
Options should be changed. 
Click the Option button in 
the bottom menu and choose 
the Extensions card. Type 
.HTM and Add. In the same 
way add .HTML as well. All 
HTML- HTM- and TXT-
files will then be transferred 
in the ASCII mode. This 
mode ensures, that all layout 
formats are transferred 
properly. All other files will 
be transferred in the binary 
code which mostly, but not 
always, keeps formats as 
well.  
To enable the new settings please open the Session (cont�d) card and choose Auto Detect. 
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To connect to the domain 
server click the Connect 
button in the bottom menu. 
Choose New and fill out the 
following fields: 
Profile Name: 
ICCD-Dresden 
Host Name / Address: 
dresden.iccd-project.net 
Host Type: Automatic detect 
User ID: iccddr 
 

 
 
 
 
The host names are: User IDs Preliminary Passwords 
dresden.iccd-project.net   
limerick.iccd-project.net   
beijing.iccd-project.net   
dhaka.iccd-project.net   
 

 
Attention: You should change your password as soon as possible. (See section: 
Administration of subdomains) to ensure that nobody but you yourself and the 
administrator of the main domain have access to your net presentation.  

 
Next choose the Startup card. Under Initial Local Folder enter the path in which you have 
your Web / Class Page files [For software training: C:\Oaz\...]. After connecting, WS_FTP 95 
LE will then directly open the respective folder. Of course WS_FTP enables you to navigate 
freely. You can initiate or change the path later on whenever you like to.  

 
I strongly recommend not to insert your password into the form. It can be used by 
everybody working on your computer and is subject to viruses and attacks while you 
are online. Select Accept. (= Übernehmen). 

For later sessions you may choose the Profile Name containing your specifications from the 
scroll bar. Press OK.  
The system will then ask you to type your password. Then you have access to your server.  
 
Once you have access you will see the directory tree of your (sub)domain in the right window 
(= remote system). 
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Your subdomain (= remote system) will contain your local Web Pages and your Class Pages. 
The Web Pages and Class Pages will be located in different sub folders.  
 
When opening your subdomain for the first time, you will find the following structure: 
 

 
 

 
The folders cgi bin, logs, and usage have been installed by our provider. Do not 
delete them! 

 
 

Renaming Folders / Files 

When working on your subdomain the first time please rename the index.htm and 
infophp.php files into index-old.htm and infophp-old.php. Mark the index.htm first, select the 
Rename button, change the name in the dialog box and hit OK.  
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Transferring Web / Class Pages 

You may now transfer your Web / Class Pages from your local computer to the remote 
system. Choose the correct folder on the remote system side by double clicking it. (Otherwise 
you will transfer all files into the top level.)  
Attention: You do not need to choose a folder when uploading for the first time! 

Mark all relevant files and folders in the Local system area and press the transfer arrow  
in the middle menu bar. (You need to mark the local_classpages and local_mainpages folders 
and the index.htm.).  
 
 

 
 
You are asked if you want to transfer the selected folders and their contents. Answer: Yes. 
 
You have now successfully uploaded your Class Pages to the internet and may view them in 
your Browser. The address is: http://[your subdomain].iccd-project.net/[local]_classpages/ 
I.e.: dhaka.iccd-project.net/dh_classpages/ 
 
Once the transfer is complete, close WS_FTP by first clicking Close and then Exit. 
 

 
Attention: If you click Exit directly your connection will stay open for some time. 
This enables pirates to spy on your login and passwords to misuse them later. 

 
 
When you leave your WS_FTP session open for a longer time, you should keep two things in 
mind: 

1. When you work on your Web / Class Pages and want to transfer changed and / or new 
pages before they are completely finished, you should press Refresh in the WS_FTP 
before the transfer so that the new file version is put on the server.  

2. The FTP connection to the server is automatically closed after a certain time when you 
have not worked in the FTP for a longer period during one session. The connection 
can be re-established by clicking Close and then Connect. Even when your FTP 
connection is closed, your internet connection is still open. 
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The top level file structure of your subdomain is as follows 
 
Remote System: 

 cgi-bin 
 logs 
 usage 
 local_classpages 
 local_mainpage 

 index.htm 
 index-old.htm 
 infophp.php 
 
 

 
If you want to delete parts of your Web / Class Pages from the remote site you have 
to delete all files from a folder before you can delete the folder itself. This may keep 
you busy for some time, but it prevents you from deleting files by mistake. 

 
 

Update your Web / Class Pages 

Throughout the term you will make changes in your Web / Class Pages, e.g. to upload 
students� reports, to add additional material etc. When you make these changes, you only 
need to transfer the file(s) you modified and not the whole directory. This is especially useful 
when you occasionally work from home, have a slow internet connection and want to save 
time you are online. 
Please make sure to open the correct folders on your local and your remote site. Some of the 
files of your Web and Class Pages have identical file names. Please do not mix them up by 
copying them into the wrong folder. 
 

 

During the transfer process WS_FTP 95 LE creates a file (WS_FTP.LOG) 
containing information about the transfer process itself and subfolders containing an 
mirror image of all transferred files and folders (_vti_cnf plus sometimes _vti_pvt). 
You will find them in both your local and the remote system. These are internal files 
of the WS_FTP programme. You are free to either leave or delete them. 
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Additional Tools 

Hyperlink 

1. to insert a hyperlink, highlight the word or phrase you want to link 

2. click the hyperlink icon  or go to Insert → Hyperlink 
3. enter the Address of the link destination 

 
If you link a page from your directory, you may select the file from the dialog box. 
 
FP 2003 

 
 
The Text to display automatically shows the word or phrase you have highlighted before. 
You are free to change it. 
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FP 2000 

 
 
A link you create within a web site is called: internal link 
If the link goes to a different web site: 

1. type / copy the address into the Address field 
2. go to the box Target Frame 
3. select New Window in 

Common Targets 
 
A link you create that points to a 
web site that is no part of your 
directory is called: external link. It 
is advised to use the Target Frame 
command New Window. Clicking 
on the link will then open it in 
another window. The window with 
your Class Pages� web site is 
retained and one can easily jump 
between the windows without 
having to hit the Back and Forward 
button endlessly. 
 

4. Click Ok 
5. clicking Ok again brings 

you back to your text 
6. save your file 
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Creating new pages  

To add a new page e.g. for longer reports, papers, or additional material etc. open the file 
blank.htm in the content / content_cp folders. Then save the file under a different filename 
(File → Save as�) i.e. smith.htm if it is to contain a paper written by a certain Smith. Take 
care to insert the correct path, i.e.: …\material\restricted. 
 
It is recommended to use only small letters for file and folder names and not to use spaces. 
Then you do not need to remember if you used small or capital letters. Additionally, frequent 
errors are prevented when you type an address into the browser because you do not have to 
ponder whether you had named a file e.g. Self Awareness.htm, Selfawareness.htm, 
SelfAwareness.HTM, SELF AWARENESS.htm, selfAwareness.htm etc. but you know that it 
can only be selfawareness.htm. Please do not use special characters either. 
 
You do not have to type the .htm extension in FrontPage when you want to save a web page 
because the extension is added automatically. 
 

1. Next add the required content to your new page. 
2. Then add a link to the source page (i.e. reports.htm) and from the source page to the 

new one. 
3. Save all pages. 

 

 
If you want to create an additional page on the content or content_cp level and want 
it to appear as a link in the left side frame, please contact the Dresden team. 

 

Standardized Formatting 

Like in a word processing document one can apply pre-made formats to texts in FrontPage, 
e.g. for headlines and paragraphs, although with much fewer choices. Additionally, the Web / 
Class Pages use a style sheet where information about the appearance of these formats is 
stored already. That means you do not need to worry about selecting a font, font size, etc. The 
style sheet also defines the look of the links so that they are always displayed equally (light 
red at all ICCD pages). In order to have these style sheet formats available in all your Web 
Pages, please make use of the template blank-page.htm, save the file under a different name 
and add you content. (See above: Creating new pages.) 
 
To properly use the formats: 
 

- highlight the text concerned and apply the desired format or 
- select the format before entering the text 
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You will find a list of styles partly containing of general styles 
to be found in every FrontPage document and partly defined 
by the ICCD team. To guarantee the ICCD visibility and equal 
appearance of all Web / Class Pages please make use of the 
latter if possible. 
The ICCD styles are the following ones: 

- Bulleted List 
- Heading 1 
- Heading 2 
- Heading 3 
- Normal 
- Numbered List 
- .oben (=top) 
- .table 
- .unten (=bottom) 

 
These styles are restricted to basic layout options. You are free 
of course to change styles (bold, italics, paragraph indentation 
and spacing etc.) as long as you keep to the general ICCD 
features (= frame appearance, colours, etc.).  
 
 

 
 

Tables 

To insert a table into your page: 
 
Place the cursor where you want to insert a table. 
 

 Please do not enter text or a table below the page�s bottom line or the Disclaimer link. 
 

1. click on the menu option Table → Insert → Table or use the table icon  
2. define the number of rows and columns  
3. set the border to 0 (no border) or to any other value for the desired border width 

 When you insert a table using the table icon, you can only select the 
number of rows and columns. In order to change the table�s width, border etc., 
make a right mouse click into the table and select Table Properties� 
 

4. when you want to make changes to the whole table, make a right mouse click into 
the table and select Table Properties� 

5. if you want to adjust a single cell�s appearance, make a right mouse click into that 
cell and select Cell Properties� 

6. you can also change the cell�s / table�s background, border colour, cell spacing, cell 
padding and much more. To explore the different functions you should take your 
time to play around with the features. 

7. save the file 
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To keep to the ICCD�s general web appearance please choose the .table format from the 
format scroll bar. 
 

 

You can align cells horizontally and vertically. The feature of alignment is 
especially useful when you create table cells of varying length, but still want to align 
them at the same height. The default option is left (horizontal) and middle (vertical). 
To align your cells at the same height and with a left alignment choose left 
(horizontal) and top (vertical) in the Cell Properties menu. 

 
Examples for tables: 
 
Border value = 1 
Default alignment 
 
This is the 
standard 
alignment of 
a table. 

It looks rather strange with uneven 
text length. 

 
The same table without borders: 
 
This is the 
standard 
alignment of  
a table. 

It looks rather strange with uneven 
text length. 

 
 
Border value = 20; Cell spacing = 20; Alignment: Horizontal: left; Vertical: top 
 

In this table the 
columns are both 
aligned at the top. 

Additionally, 
the cell 
spacing and 
the border 
value are set 
to "20" . The 
first allows 
more space 
between the 
cells 

The texts start both at the top even with 
different column length. 
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Pictures 

To insert a picture into your page: 
 
Place the cursor where you want to insert a table. 
 

 Please do not enter text or a table below the page�s bottom line or the Disclaimer link. 
 

- click on the menu option Insert → Picture → from File or use the Insert picture from 

File icon  
- choose a picture from the folder where you have saved it and click Insert 
- right mouse click on the picture and choose Picture Properties � 

 

 
 
Set the properties, especially Width and Height properly. 
 
 

Customizing the Students� Page 

To customise your Students� page please advise your students to send you by email: 
- a short introductory text about themselves (name, age, interests, hobbies etc.) of about 

50 words in length. 
- a newer photo in a jpg or gif format 

 
Copy all photos into the Class Pages� content_cp/students folder. 
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Now open the student.htm file in the Class Pages� content_cp folder and insert the pictures 
one by one into the photo space, which is visible on the page. Follow the instructions above in 
paragraph Pictures (p. 20).  
 

 According to the original size of the photo given to you, the cell spacing of the 
underlying table may change instantly.  
 
To restore the proper spacing of cells and to ensure that all photos appear more or less at the 
same size please open the Picture properties � menu and set the Height to 100 pixels. The 
Width should then be around 70.  
 
To insert the students� introductory texts open the file (Word document, email etc.) containing 
the description send to you by your students. Mark and copy the relevant text into the 
student.htm file at the proper place.  
 

 According to the original format of the text given to you, the cell spacing of the 
underlying table may change instantly.  
 
Please mark the text and apply the format Normal from the format scroll bar in the top menu. 
(see section Standardized Formatting, p. 17). If the student�s text is longer than the given 
amount of words the cell�s height will increase automatically to a fitting size. Please pay 
attention that the length of the students� introductory texts is approximately the same. The 
corresponding picture is aligned to the cell�s middle level. 
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Administration of Subdomains 

Login 

To administer your subdomain open your browser and go to http://www.all-incl.com. 
 
You will see a German language welcome page. Click the Support button in right top menu. 
Next click the KAS Login in the left side frame. 
 

 
 
Please enter your subdomain into the field: Ihre Domain: i.e. 
 
Sub domain names are: User IDs Preliminary Passwords 
dresden.iccd-project.net   
limerick.iccd-project.net   
beijing.iccd-project.net   
Dhaka.iccd-project.net   
 
In the language box below choose: english and click the Login button. 
Then you will see a dialog box. Enter your User ID and your password. 
 
Attention: You should change your password as soon as possible to ensure that nobody but 
you yourself and the administrator of the main domain has access to your net presentation.  
 
 
 
 
 
 
 

http://www.all-incl.com/
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Depending on your browser options you will see the following message. Hit Ok. 
 

 
 
 
 
You will then see the main 
menu: 
Relevant tasks are: 
 
 
→ E-Mail Accounts 
 
 
→ Directory Protection 
 
 
 
 
 
 
→ Change Password 
 

 
 
 

Manage your E-Mail Accounts 

To install e-mail accounts select the Manage your E-Mail Account radio button and click 
continue. 
 
You have three choices: 

- manage POP3-Accounts 
- manage forwardings 
- manage autoresponders 
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POP3-Accounts and Forwardings 
 
There are two generally different possibilities to use name@iccd-project.net e-mail addresses.  
 

1. A physical address as a POP3-Account. You will get a login and a password and can 
use your normal e-mail programme to send and get messages. The incoming mails will 
be stored in the ICCD domain�s web space until you download them on your 
computer. You have to check your account regularly.  
Outgoing mail shows the name@iccd-project.net address as sender.   
→ Receive and send function. 

2. A virtual address. All incoming mail will be forwarded to an e-mail address of your 
choice. You will not have to check an additional address all the time.  
You can not send mails showing a name@iccd-project.net address as sender. All 
outgoing mail will go via your regular e-mail account  
→ Receive function only. 

 
Please note that we have installed all personal e-mail addresses directly on the top level 
domain as name@iccd-project.net since this is more convenient than the addresses from the 
subdomains, which would be: name@local.iccd-project.net. 
 
It is therefore recommended to use the Manage your E-Mail-Accounts function only to 
install additional functional e-mail addresses like info@local.iccd-project.net etc. 

 
The number of available POP3 addresses is limited. Please contact the Dresden team 
before installing a POP3 Account. 

 
If you want to use other administrative functions of your subdomain click Back, otherwise 
leave the Administration Area by simply closing the page. 
 
 

Directory Protection 

You may want or need to protect single files or documents from general access and to restrict 
the access to a certain group of persons. This is e.g. useful if you add scanned material from 
books for your students or if you do not want texts to be open to the public. To a certain 
extend you can escape charges with copyright violations. Protected pages are for internal use 
only.  
 
To install a directory protection select the Directory Protection radio button and click 
continue. 
 
You will find a short text introducing the use of this function. 
 
To protect pages from your Class Pages enter the complete path [i.e.: \dd-
classpages\content_cp\material\restricted] into the Directory field. Then enter a User name 
(i.e. student) and a Password (i.e. Weber). Click the Save button. 
 
You have now installed a protection for all pages, files, pictures in the directory 
material\restricted in your Class Pages. This means that you have to save all relevant 
documents in this directory. 
Try now to enter the Restricted Area in your Class Pages Material page. A dialog box will 
appear and ask for the User ID and the Password. 

mailto:name@iccd-project.net
mailto:name@iccd-project.net
mailto:name@iccd-project.net
mailto:name@local.iccd-project.net
mailto:info@local.iccd-project.net
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The legal status is not completely clear.  
 

- Do not reproduce complete or longer text passages from a book.  
- Do not copy more than the really relevant pages or a single chapter / essay / 

dictionary�s entry etc.  
- Choose a password that is not easy to detect (not: your name, parts of the 

module name, words that occur prominently on your Class Pages).  
- Instruct your students not to tell the login and password to others.  

 
According to our experience you won�t get legal problems if keeping to these rules. 
 
If you want to use other administrative functions of your subdomain click Back, otherwise 
leave the Administration Area by simply closing the page. 
 
 

Change Password for this Account 

Select the Change Password for this Account radio button and click continue. 
 
Enter your new Password and repeat it in the second box. Click Save. 
 
You will get the massage: Your Password will be changed. When you click the Back button, 
the system instantly requires your User ID and your new password before you get access to 
any other administrative tasks. 
 
 
 


